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Introduction and Welcome
Welcome to ZagNet, Gonzaga’s student network. As a user of ZagNet, you have high-speed
access to campus computing resources, the Internet, electronic mail, and the World-Wide Web.
You also have a technical support team to assist you with using ZagNet should you encounter
problems. ZagNet alleviates the need to use a modem to dial into the library or check your e-mail.
You can now do that from the convenience of your computer without tying up your phone line.

What Comes with ZagNet?

ZagNet is the student network and support system. It includes network access from your
residence hall, software for your computer, and technical support staff should you encounter
problems. It also includes academic resources such as access to the library and academic software
on Barney and Betty, Gonzaga’s main academic servers. Your ZagNet account gives you an e-
mail account that you keep your entire time at Gonzaga, access to a server where you can house
your personal web page and store documents and other files, and Usenet, a global discussion
network consisting of thousands of discussion groups.

Where to Begin?

There are a couple of steps you should take to prepare to use ZagNet.

• Purchase and install a network card for your computer*
• Install the ZagNet software on your computer*
• Pick up your ZagNet account**

*Purchasing of the network card is available during Orientation Weekend at Connection Central in
the Crosby Center. Configuration assistance is available on the ZagNet CD you receive with your
network card and through the Help Desk at x5550. Onsite assistance is also available if required.

**Picking up your ZagNet account can be done during Orientation Weekend at Connection
Central in the Crosby Center and in the AD016 Computer Center the rest of the year during
normal working hours. Computer lab operators can also provide your account information.

Once you have your network card and ZagNet software installed, go through this manual to
configure individual programs included with ZagNet. These include Internet Explorer 5.x and
Outlook Express 5.x and optionally QvtNet (PC), NCSA Telnet (Mac), and Fetch 3.0 (Mac).

If You Need Assistance

If you require assistance with connecting to the network or using the included ZagNet software,
contact the Help Desk at x5550 from 8:00AM to 4:30PM Monday-Friday.
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ZagNet Support Services
Help Desk Information - x5550

As a part of ZagNet, Gonzaga University has a technical Help Desk. Students, faculty, and
employees are able to call a single telephone number and receive help in solving computer-related
problems. Students who are having problems connecting to ZagNet can call the Help Desk staff,
who will help them diagnose and solve basic network-related problems. If the problem can't be
quickly resolved, and appears to be network-related, the Help Desk staff will initiate a work
order and transmit it to a support technician who will work with the student to resolve the
problem. In addition, the Help Desk staff tracks all unfinished work orders to ensure they are
resolved. Students who are experiencing problems connecting their computers to ZagNet or the
Internet or using any of the supported applications can send e-mail to helpdesk@gonzaga.edu or
call x5550 to talk to a Help Desk staff member.

Supported Applications

ZagNet provides students with access to a broad range of electronic resources. Students are able
to create their own web pages, electronically submit assignments, search the World-Wide Web for
research and other materials, run academic software applications, communicate with others both
on and off campus, and access scholarly research materials and electronic journals, all from the
comfort and convenience of their rooms. Available resources include student e-mail, the World-
Wide Web, academic software, Endeavor - the Foley Center online library catalog, the Project
MUSE electronic research journal collection, Bell and Howell’s Proquest, and thousands of other
information resources available through the Internet.

As a part of this network access, Gonzaga will provide students with limited support for
computer and network software. Students who need help connecting to the ZagNet network and
the Internet, or who have questions about using Internet Explorer, Outlook Express, ZagMail,
QvtNet, NCSA Telnet, or Pine, should call the Help Desk at x5550 to receive assistance.

The university support staff will not be able to provide support for other hardware issues or
software applications. For other software and hardware issues, students should call the vendor’s
support line or visit their website for assistance.

Further Information

This manual is intended to provide a basic introduction to ZagNet services and applications.
More extensive information is available in the electronic manuals for the applications and on
Barney’s web site at http://barney.gonzaga.edu.

http://barney.gonzaga.edu.
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Academic Computing Services Basics
Gonzaga University provides a number of servers for student use. These systems provide access
to student e-mail, personal web pages, document storage, Usenet news, and specialized programs
for specific courses. These applications include web development, programming languages, and
statistical packages. The three primary servers that students will use are:

Barney – Gonzaga’s main academic server. Stores e-mail, web pages, and student files.
Betty – Provides access to specialized applications such as SPSS and Minitab.
ZagMail – Web interface to the e-mail stored on Barney.

Barney, Betty, and ZagMail are available both from on-campus and from anywhere on the
Internet. Barney (student web pages) and ZagMail (student web-based mail) are both available
using a web browser. Barney and Betty can be accessed using either a telnet or SSH client. Mail
stored on Barney can also be accessed using any mail client that supports IMAP or POP3.

All of Gonzaga’s central academic servers and most of the computer labs use a ZagNet account to
provide access to their services. Your ZagNet account is active as long as you are a student at
Gonzaga. You can pickup your username and password during Orientation Weekend in Crosby
Center or anytime during the year in the AD016 Computer Center. Your account provides you
with up to 100 megabytes of storage space for your documents, web pages, and e-mail.

Document Storage from the Computer Labs

When a student logs into a workstation in one of Gonzaga’s computer labs using their ZagNet
account, they will have direct access to their home directory on Barney. Documents can be
created on the workstation and stored directly in their home directory. This provides a secure
location for student documents. Any files that you store on Barney are available from any
computer lab that uses the ZagNet login or by using an FTP client.

Accessing Applications on Barney and Betty using Telnet/SSH

Some classes require that students access programs that run either on Betty or Barney. These
applications are accessed using either a telnet or SSH client. Barney is accessed by telnetting to
barney.gonzaga.edu and Betty is available at betty.gonzaga.edu. See http://barney.gonzaga.edu
for more information on which programs are on which server. Telnet and SSH clients are available
at http://cws.internet.com/internet.html. More information for using telnet and SSH is available at
http://barney.gonzaga.edu.

Off-Campus Access to Gonzaga Computing Services

Access to Gonzaga’s computing services from off-campus requires that students have their own
Internet Service Provider.

http://barney.gonzaga.edu
http://cws.internet.com/internet.html
http://barney.gonzaga.edu
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Accessing Student Mail

E-mail is also available with your ZagNet account. Your e-mail can be accessed using a web
browser, an IMAP/POP3 client such as Outlook Express, or Pine via a telnet client. Your e-mail
address is your ZagNet username followed by “@gonzaga.edu” (e.g., msmith7@gonzaga.edu).

Your e-mail account can be accessed using any web browser at http://zagmail.gonzaga.edu.

Students that want to use an IMAP/POP3 client should use the following settings:

IMAP or POP3 Server: barney.gonzaga.edu
SMTP Server (on-campus): barney.gonzaga.edu
SMTP Server (off-campus): Your ISP’s SMTP server

Students can also use a telnet or SSH client to access their e-mail using the Unix pine program.
Telnet to barney.gonzaga.edu to access your mail using pine.

E-Mail Activation and the Gonzaga Web Directory

ZagNet accounts picked up in the AD016 Computer Center or during Orientation Weekend are
automatically configured as e-mail accounts. If the account is picked up during class or in a
computer lab, it may not initially be activated for e-mail. To activate your account to use e-mail,
go to http://barney.gonzaga.edu and click on “ZagNet Mail Settings.” Once you’ve logged in,
check “Activate E-Mail Account” and click “Submit” to enable your account to begin receiving
e-mail. If you need assistance activating your e-mail, contact the Help Desk at x5550. You don’t
have to activate your e-mail to use your account to store documents or to create web pages.

If your e-mail is activated, it will be listed in Gonzaga’s mail directory. Students can also choose
to list an off-campus address in the directory or have their address hidden if they prefer. The web
directory is available at http://barney.gonzaga.edu/email.

Password Security

It is important to change your ZagNet password from the password that is initially provided. It
is also recommended that you change your password periodically. Your password can be changed
when logged into a computer lab workstation, when logged into ZagMail, or using the passwd
command while logged into either Barney or Betty using telnet. Your password must be at least
six characters long and contain at least one digit or special character.

Further Information

More extensive information is available on Barney’s web site at http://barney.gonzaga.edu. Phone
support is also available through the Help Desk at x5550 during normal working hours.

http://zagmail.gonzaga.edu
http://barney.gonzaga.edu
http://barney.gonzaga.edu/email
http://barney.gonzaga.edu
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Using the World-Wide Web
What is the World-Wide Web?

The World-Wide Web (the Web) is composed of millions of independent web servers containing
billions of web pages that are loosely linked together. These web servers are owned and operated
by companies, schools, organizations, the government, and individuals. There are nearly a dozen
university operated web servers at Gonzaga alone. Because of the distributed nature of the Web
and the Internet, the reliability of individual web servers may vary. What may be accessible one
day may be down the next. Such is the nature of the Internet.

The Web contains information on almost every topic. Since the content of the Web is created by
many individuals, many diverse opinions exist on the Web. Content is often governed by a policy
at the location where the web server is located. This is the case with Gonzaga; any information
that is placed on a web server at Gonzaga (whether university owned or private) is governed by
Gonzaga’s Acceptable Use Policy.

Using Internet Explorer 5 for Web Browsing

The most difficult part of using Internet Explorer as a web browser is understanding how the
World-Wide Web works. By understanding the basics of how to access documents on the Web,
you are well on your way to utilizing the most common features of Explorer.

Understanding URLs

URLs (Universal Resource Locators) are the addresses of the Web. URLs are used to describe the
location of web pages on the Internet. Using a URL, you can locate any web page on the Internet.
The structure of a URL is fairly simple: it consists of a protocol identifier, a server address, and a
web page name. For example, the URL http://www.gonzaga.edu/zagnet/index.html specifies
the hypertext transfer protocol (http), the www.gonzaga.edu web server, and the web page
named /zagnet/index.html (/zagnet/ is the path to the file) on the www.gonzaga.edu web server.
There is typically a default web page on each web site that alleviates the need to specify a web
page name unless you want to go to a specific page on that web server. For example, the URL
http://www.gonzaga.edu will automatically load the default web page on the www.gonzaga.edu
server.

Since a URL is the unique address to a web page, to go back to a web page in the future, the only
thing you have to remember is the URL. Internet Explorer will use the URL to locate the web
page and reload all of the data for that web page. By keeping a list of URLs, you can easily return
to pages you have visited before. You can also send a person a URL via e-mail and the other
person can use the URL in their copy of Internet Explorer or any other web browser and load the
same page you saw.

http://www.gonzaga.edu/zagnet/index.html
http://www.gonzaga.edu
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Loading a Web Page using a URL

If you have the URL for a web page, you can easily go to that web page using Internet Explorer.
To load a web page using a URL, do the following:

1. Launch Internet Explorer.

2. Select “Open...” from the File menu.

3. Enter the URL to open and click “OK.”

Explorer will attempt to contact the web server where the web page described by the URL is
located. If the web server is busy, unavailable or doesn’t exist, Explorer will report an error. If
this happens verify that you entered the URL correctly and try again or wait and try again later.

Links

One of the most powerful features of the World-Wide Web
(and the reason that it’s called a web) is the ability for one
web page to link to another web page. A link is created by
embedding a URL within a web page. These “links” to other
pages are normally indicated on the web page as underlined
colored text (typically blue). By clicking on the link, Internet
Explorer will attempt to locate the server for the link’s URL and load the new web page. This is
just as if you had manually entered the URL in the Open dialog box.

These links are not limited to linking to other web pages. They can also refer to an e-mail address,
a file to be downloaded, an audio or video clip, etc. These are all special forms of URLs that help
make the World-Wide Web a rich environment. For example, the Downloads web page on Barney
(http://barney.gonzaga.edu/tech/download.html) is a list of links that will download files from
Barney through anonymous FTP if they are clicked on.

Bookmarks

There are millions of web pages on the World-Wide Web.
Among those, you will find a number of pages that you
want to return to later. Rather than write down the URL
and manually enter it each time you want to go to that
web page, you can create a bookmark for that page. A
bookmark remembers the URL and the title of the page
and stores this information in a bookmark file. These
bookmarks are available under the Favorites menu.

http://barney.gonzaga.edu/tech/download.html
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To add a web page to your bookmarks, do the following:

1. Go to the web page you wish to bookmark.

2. Select “Add to Favorites…” from the Favorites menu.

Once you’ve added a bookmark to your Favorites menu, all
you need to do to go to the web page you’ve bookmarked
is to select the bookmark from the Favorites menu.

After you have accumulated a large number of bookmarks, you may find that the Favorites menu
gets cluttered. You can clean up the Favorites menu by selecting “Organize Favorites …” from
the Favorites menu. This will open a window that will allow you to delete old bookmarks and
arrange bookmarks into folders (folders show up as sub-menus within the Favorites menu).

Finding Information on the World-Wide Web

As mentioned earlier, the World-Wide Web contains billions of web pages that are constantly
changing. Because of this, locating information could be difficult. Fortunately, there are a number
of “search engines” on the World-Wide Web that make it easy to search the Internet. These
search engines are constantly searching the Web for new or changed web servers and pages. The
information they find is added to
their databases which are indexed
for easy and fast searching.

Using any of these search engines,
you can do a keyword search that
will effectively search millions of
web pages in just a few seconds.
The search engine returns a list of
links that match your search
criteria. The better the search
criteria you enter, the better the
search results. For example,
searching for “Word help” would
return many thousands of hits but
searching for “Microsoft Word
printing problem” makes the
search more specific.
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Here are some search engines you may find useful:

http://www.google.com http://www.altavista.com
http://www.yahoo.com http://www.lycos.com

Yahoo (http://www.yahoo.com) has an extensive list of search engines on their web site. To find
the list, go to Yahoo and search for “search engines.”

Finding E-Mail Addresses on the Web

While there is no master directory of e-mail addresses on the Web, many organizations maintain
online e-mail directories for their employees and for universities, their students. Gonzaga
provides such a directory at http://barney.gonzaga.edu/email. This page also has links to several
sites that search the Internet for e-mail addresses and add them to their databases similar to how
web search engines build their databases.

If you are looking for the
e-mail address of a specific
person, you can see if the
company they work at or
the school they attend has
an online directory like
Gonzaga’s. You can also
search one of the national
e-mail directories for their
name and e-mail address or
you can even search one of
the web search engines like
Alta Vista or Yahoo for
their name.

For More Information on
Internet Explorer

Internet Explorer and the
World-Wide Web have
many features that cannot
be included in such a short
introduction. For information on these features, use Explorer’s built-in help system. To access
help, use the “Help” menu inside of Internet Explorer. To learn more about the Internet, just
hope on the nearest browser and explore!

http://www.google.com
http://www.altavista.com
http://www.yahoo.com
http://www.lycos.com
http://www.yahoo.com
http://barney.gonzaga.edu/email
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Configuring Outlook Express 5.0
Requesting an E-Mail Account

It is recommend that you already have your e-mail (ZagNet) account before configuring Outlook
Express. Accounts are available Friday, Saturday and Monday of Fall Orientation Weekend at
Connection Central in the Crosby Student Center. During the rest of the year, they are available
in the AD016 Computer Center during normal working hours.

What is Outlook Express 5.0?

Outlook Express 5.0 provides e-mail, Usenet news, and directory service access. It can compose
messages in html and plain text formats, has an integrated spell checker, and a powerful address
book. The next three chapters will cover the configuration and use of Outlook Express. This
chapter will go through the configuration, the next will discuss reading and composing mail, and
the final chapter will discuss reading Usenet news using Outlook Express.

It is highly recommended that you use Outlook Express 5.0 or later. The ZagNet installation
process will install Outlook Express 5.01 for Windows or Outlook Express 5.02 for Macintosh.
These later versions have much better support for IMAP and have more extensive features than
earlier versions.

POP or IMAP Mail Protocol

Gonzaga's student mail server, Barney, supports two types of mail protocols, POP (aka POP3)
and IMAP. When you configure Outlook Express, you will need to select either POP or IMAP.
This won't effect how your mail is sent or looks, but it will change where it is stored. You can
always change your mind and switch the protocol you want to use later.

The primary difference between POP and IMAP is that POP downloads all your messages from
the mail server to your local hard drive and then deletes them from the mail server. IMAP keeps
the mail on the server and downloads only those messages you click on to read.

POP’s primary advantage is that all of your messages are downloaded at once. It can also be
configured to periodically check the mail server for new mail. Since it connects only periodically,
any mail that has already been downloaded to your local computer can be read even if the
network is down or the mail server is offline. The disadvantage of POP is that once the messages
are downloaded to your local hard drive, you can’t read the downloaded mail from another
computer (e.g., from ZagMail, another room, or from a computer lab). This disadvantage can be
diminished by turning on the “Leave messages on server” option but this means that you’re
keeping two copies of every message; not very economical.
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IMAP is a newer protocol that was designed with the premise that the client computer (you) are
always connected to the network and that the mail server is always available. It keeps all of the
messages on the mail server and only downloads the header information for the mail messages
(subject, sender, recipient, and length). When the user clicks on a message, IMAP downloads the
rest of the message from the mail server for display but doesn’t delete it from the server. IMAP
also allows you to utilize mail folders on the server for filing messages. These folders are
compatible with ZagMail and Pine so that all of your mail is available not only from Outlook
Express, but from the web and directly on Barney or Betty as well. This is advantageous if you
want to be able to read and file mail from other computers besides your own, including
computers off-campus. The disadvantage of IMAP is that it is slightly slower than POP because
it must retrieve messages from the mail server rather than from your local hard drive.

POP is recommended for those users that are only going to read their e-mail from one computer.
It is also recommended for those users that have older computers. IMAP is recommended for
those users that want full access to their e-mail regardless of the computer they are using.  More
information on IMAP and POP can be found at http://www.imap.org.

A Note Regarding Outlook Express 5.02 for Macintosh

The following configuration guide deals primarily with the configuration of Outlook Express for
Windows. The Macintosh client offers similar functionality but the layout of the windows and
the configuration options are slightly different. The following instructions should be sufficient to
configure the Macintosh client as well.

Configuring Outlook Express 5.0

The configuration for Outlook Express is easiest when using the Internet Connection Wizard.
The wizard runs automatically when Outlook Express is launched for the first time. After the
initial account is created, a new account can be added by selecting “Accounts” from the “Tools”
menu in Outlook Express and then clicking on the “Add” button in the Internet Accounts
window that appears and selecting “Mail.…” You can also modify the settings for your account
by opening the same Internet Accounts window.

The information you will be entering includes your e-mail address and name, various server
addresses, and other details. Multiple users can use the same computer by creating multiple
“Identities.” This manual does not include instructions on setting up identities or other advanced
options. Refer to the Help menu in Outlook Express for information on additional configuration
options.

http://www.imap.org
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Configuring E-Mail

To configure Outlook Express, do the following:

1. Launch Outlook Express.

You may receive a warning that Outlook Express is not your default mail client. If you are
only using Outlook Express on this computer, you will probably want to make it the default
mail client.

2. Enter your name and then click the “Next>” button.

If Outlook Express launches directly to its main window, at least one account has already
been created. A ZagNet technician or someone else may have already created the account for
you or Outlook Express might have been installed and configured prior to your arrival at
Gonzaga. You can see whether you already have the account configured by selecting
“Accounts” from the “Tools” menu, clicking on the “Mail” tab, and examining the list of mail
accounts. If you already have one setup then, you can probably ignore the remaining steps.

If you aren’t sure, create a new account by selecting “Accounts” from the “Tools” menu,
clicking on “Add” button in the Internet Accounts windows, and selecting “Mail….”

3. Enter your e-mail address and click “Next>.”

Note: If you don’t have an e-mail address yet, you will not be able to proceed further with
the configuration of Outlook Express.

4. Select your preferred method for downloading e-mail
from Barney.

Note: IMAP is recommended unless you will only be
reading mail from this computer.

5. Enter “barney.gonzaga.edu” as the incoming and
outgoing mail server and then click “Next>.”

6. Enter your mail server username and then click “Next>.” This is your ZagNet username for
logging into Barney and the computer labs (e.g., francis or msmith7).

Warning: At this point, you can elect to enter and save your password. If you choose to do
this, anyone that has access your computer will be able to read and send e-mail as you.
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7. Click “Finish” to save your mail account settings.

If this is your first account in Outlook Express, you will be given the option to import
information from other mail clients. Unless you have information you want to import, simply
click “Next>” and then “Finish” to skip importing information from other mail clients.

8. If you selected IMAP as your mail server type in step 4 above, do the following steps. If
you selected POP3, skip to step 9.

a. Click “No” when asked if you want to download a list of folders.

b. Select “Accounts” from the Tools menu.

c. Double-click on the “barney.gonzaga.edu” mail account.

d. Click on the “IMAP” tab.

e. Uncheck “Check for new messages in all folders.”

f. If you want to save your sent mail on Barney, check
“Store special folders on IMAP server” and enter
“sentmail” as your Sent Items folder and “drafts” as
your Drafts folder.

Note: The good thing about keeping your outgoing mail in a folder on Barney is that it
will be accessible from anywhere. The downside is that it will take longer to send
messages and it will count toward your 100MB disk limit on Barney.

g. Click “OK” to save your settings.

h. Click “Close” to close the Internet Accounts window.

i. When asked if you want to refresh your folder list, click “Yes.”

j. Enter your password and click “OK.”

Note: If you have requested your account, but it hasn’t been created yet, you will receive
an error that you could not connect to your account on Barney.

Configuring Usenet News

9. Select “Accounts” from the Tools menu.
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10. Click on the “Add” button and select “News….”

11. Verify your name and click “Next>.”

12. Verify your e-mail address and click “Next>.”

13. Enter “news.gonzaga.edu” as your news server and
click “Next>.”

14. Click “Finish.”

Configuring Gonzaga White Pages (Directory Services)

15. Click the “Add” button and select “Directory Service….”

16. Enter “whitepages.gonzaga.edu” as the LDAP server and click “Next>.”

17. Click on “Next>” to skip auto-checking of addresses.

18. Click “Finish.”

19. Double-click on “whitepages.gonzaga.edu” to make
additional changes.

20. Change the descriptive name to “Gonzaga White Pages.”

21. Click on the “Advanced” tab.

22. Set the Search Base to “o=Gonzaga University, c=US”.

23. Click “OK” to save the changes.

24. Click “Close” to close the Internet Accounts window.

Note: You will now be asked if you want to download the current list of newsgroups. If you
choose to do so, you will also be given the opportunity to subscribe to newsgroups.

At this point, you have configured Outlook Express to read and send electronic mail, access
Gonzaga’s Usenet news server, and to be able to query Gonzaga’s directory service to lookup
e-mail addresses for people at Gonzaga. To learn how to use these services, go to the appropriate
chapters in this manual or use Outlook Express’ help system.
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Using Electronic Mail (Outlook Express)
Electronic mail, more commonly referred to as e-mail, is one of the oldest and most popular uses
of the Internet. Gonzaga’s electronic mail system allows you to communicate with other
students, faculty, and staff on campus and anyone that is connected to the Internet, either
directly or through an online service such as America Online. Electronic mail has historically been
the most popular network service at Gonzaga.

Students are provided a number of e-mail clients to choose from. The three supported clients are
ZagMail, Outlook Express and Pine. ZagMail is the web interface to your mail and is available at
http://zagmail.gonzaga.edu. Pine is a text-based mail program on Barney accessed using telnet and
is described in the separate document “Using Electronic Mail (Pine).” Outlook Express is a free
graphical client available from Microsoft for both the Macintosh and Windows that also includes
a Usenet client and other capabilities.

This document will provide some basic information regarding e-mail and will also provide
information on using Outlook Express to read and compose e-mail.

Your E-Mail Address

Everyone at Gonzaga has the option of getting an account on Barney. For those that are using
these accounts for e-mail, their e-mail address is username@gonzaga.edu where “username” is
your ZagNet account name. For example, if my name was Jane Doe and my username (account)
was jdoe, my e-mail address would be jdoe@gonzaga.edu. Students using other servers would put
the server name and domain after the “@.” As an example, if Jane were on the Grace server in
Computer Science, her address would be jdoe@cps.gonzaga.edu. Most students will use Barney
as their e-mail server so their address will end with “@gonzaga.edu.”

Locating an E-mail Address for Someone at Gonzaga

It is often desirable to locate another person’s e-
mail address to send them mail. Gonzaga has a
search engine on the Web and on Barney to look
for someone’s e-mail address based on either
their first or last name. The web-based search is
at http://barney.gonzaga.edu/email.

If you telnet into Barney, you can type “mailid
keyword”, replacing keyword with a portion of
the person’s name (e.g., “mailid jane” would list
all of the Janes at Gonzaga).

http://zagmail.gonzaga.edu
http://barney.gonzaga.edu/email
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Gonzaga also has something called the “Gonzaga White Pages.” These white pages can be
searched from either Outlook Express or from within Pine.

To search the white pages from within Outlook Express, do the following:

1. Click on the “Addresses” icon in the main Outlook Express menu.

The Address Book window will appear.

2. Click on “Find People” icon in the Address Book window.

3. Select “Gonzaga White Pages” from the “Look
in” popup menu.

Note: If “Gonzaga White Pages” isn’t listed,
go to the section titled “Configuring Outlook
Express 5.0” to add the directory (step 15).

3. Enter part of the name of the person you want to search for in the “Names” field. For a more
advanced search click on the “Advanced” tab.

Note: Students that have requested confidentiality will not appear in the e-mail directory. If
you are on the directory and would like to be removed, contact Greg Francis at x6896 or
francis@gonzaga.edu.

4. Right-click on the person you would like to send mail and select “Send Mail” from the Action
sub-menu. A dash in place of their e-mail address indicates the person doesn’t have a known
e-mail address.

Checking and Reading Mail in Outlook Express (POP3)

When using POP3, your mail must be downloaded from Barney to your local computer before it
can be read. Once it is on your local computer, it can be read, replied to, filed, and/or deleted. All
mail folders are stored on your local hard drive. All new mail is downloaded from Barney into
your Inbox folder.

You can either have Outlook Express check mail for you automatically (see Options under the
Tools menu) or you can force it to check for mail by clicking on the “Send/Recv” in the main
window. Outlook Express must be running on your computer in order for it to automatically
download mail.
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If you have new mail on Barney, Outlook
Express will download all of the mail to your
local computer. If the messages are long or
contain file attachments, this may take a few
moments. The status bar at the bottom of the
main window will indicate how many read
messages you have..

To read the mail in your Inbox, do the following:

1. Launch Outlook Express.

2. Click on the “Inbox” in your folder list.

3. If you check mail manually, click the “Send/Recv” button to download your new mail.

4. Click on the message that you want to read. The text of the message will appear below.

5. Once you’ve read the message, you can delete it by clicking on the “Delete” icon at the top of
your Inbox window or you can file it into another folder by clicking on the “File” icon.

Note: It is recommended that you either delete the mail from your Inbox or file it to another
mailbox if you want to keep it for later use. This keeps your Inbox uncluttered and will help
it respond quicker, especially on older computers.

Creating Folders for Storing Mail (POP3)

You can create additional folders to file your mail in so it doesn’t clutter your Inbox. This is
useful because it also allows you to group all the mail for one topic or person into a single
location. To create a folder, do the following:

1. Right-click on “Local Folders” and select “New Folder….”

2. Enter the name of the new folder and click “OK.”

The folder will now be listed in your folder list under Local Folders. To save messages into
this folder, just drag the message from its current folder to the new folder.
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Checking and Reading Mail in Outlook Express (IMAP)

When using IMAP, portions of your mail will reside on the remote server (Barney) and portions
can reside on your local drive. This allows you the maximum flexibility when using Outlook
Express but it can also be somewhat confusing as well.

Reading and filing mail with IMAP is nearly
identical to using POP3 with the exception that
IMAP adds an additional folder set to your folder
list. This folder is called “barney.gonzaga.edu.” It
contains your Inbox on Barney and any mail
folders you have on Barney as well. Any folder in
here is also going to be accessible from ZagMail or
Pine. Folders that reside in “Local Folders” are on
your local hard drive and cannot be accessed by
either Pine or ZagMail.

To read your mail, follow the same steps as you would for reading POP3 mail above but open up
the Inbox in “barney.gonzaga.edu” instead of “Local Folders.” The same applies for creating mail
folders and filing mail. You can create mail folders either on Barney or your local drive. If you
want it to be available from ZagMail and Pine, create the folder in “barney.gonzaga.edu.”

Composing New Mail

Outlook Express makes it easy to compose new e-mail messages. It includes an address book
feature, the ability to easily attach files to messages, and also the ability to copy text from a word
processor directly into an e-mail message.

To create a new message, do the following:

1. Launch Outlook Express.

2. Click the “New Mail” icon or select “Mail
Message” from the “New” sub-menu of the
File menu.

An empty message window will appear.

3. Enter the recipient’s address in the “To:”
field. To enter multiple addresses, just
press the Enter key; Outlook Express will
add additional lines as needed.
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If you don’t know the person’s address and they are at Gonzaga, you can select “Address
Book…” from the Tools menu to search Gonzaga’s White Pages. See the instructions earlier
in this chapter for more information.

4. Enter the subject of the message in the “Subject:” field.

5. Click in the body of the message and either type the message or copy and paste the message
from another program.

6. If you wish to attach a file to the message, do the following:

a. Click on the “Attach” icon at the top of the message window.

b. Locate the file you want to attach, highlight it and click “Attach.”

7. Click on the “Send” button in the message window to send the message.

Creating a Signature

A signature is a block of text that is appended to the end of new messages. A signature is usually
used to provide information about the person sending the message. People often include e-mail
addresses, phone numbers, employer, titles, and cute little quotes in their signature. To create a
signature in Outlook Express, do the following:

1. Select “Options…” from the Tools menu.

2. Click on the “Signatures” tab in the Options window.

3. Click on the “New” button to create a new signature.

4. Enter the text of the signature in the “Edit Signature”
block at the bottom of the window.

6. To include your signature on all outgoing mail, check the
“Add signatures to all outgoing messages” checkbox.

7. Click “OK” to save your new signature.

For More Information

Outlook Express includes many additional features that you may find useful. To learn more
about these features, use Outlook Express’ help system available under the “Help” menu.
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Using Usenet News
What is Usenet?

Usenet is a network of thousands of servers on the Internet that house thousands of discussion
groups called newsgroups. Each server can be configured to carry a select number of the
newsgroups or all of the newsgroups. These “news” servers periodically connect with one
another to pass along any new articles that were created on its server or that were passed to it by
another news server. Because of this distributed architecture, an article posted on Usenet may
take several days to be distributed to all of the news servers that carry the newsgroup where the
article was posted.

Gonzaga’s news server carries approximately 10,000 of the most commonly read newsgroups of
the more than 35,000 newsgroups on Usenet. Most of the other newsgroups are either regional,
for companies, or for a very specific group. Requests for adding a newsgroup that Gonzaga
doesn’t carry can be sent to Greg Francis at francis@gonzaga.edu. As an example, the Seattle
newsgroups were added at the request of someone from the Seattle area. Newsgroups designated
for the posting of files such as music or images will not be carried because of the excessive disk
space required to store the files.

What is a Newsgroup?

A newsgroup is a discussion area on Usenet that was created for the posting of a specific topic.
Topics can be anything; examples include artificial intelligence, the show Friends, politics, and
skydiving. Many of these newsgroups are purely for entertainment while others can yield
valuable information for research projects. One thing to remember about newsgroups is that
anyone can post to them; this means all information on Usenet should be questioned and verified.

In addition to the Usenet newsgroups, there is a set of newsgroups that are local to Gonzaga.
Each of these newsgroups begin with “gu.” to indicate it is local to Gonzaga. Anything posted in
one of these groups is not distributed outside of the university. Topics for the Gonzaga
newsgroups include announcements, events, and the sale of textbooks and other items. Clubs and
other campus organizations can request a newsgroup of their own by contacting Greg Francis at
francis@gonzaga.edu.

To make finding newsgroups easier, newsgroups are given names that group them into categories
and subcategories. For example rec.skydiving means the subject of skydiving in the recreation
category. Newsgroup names can get fairly complex; for example rec.arts.sf.tv.babylon5.info is
for information on the science fiction television show Babylon 5. Fortunately, newsgroup names
are searchable making it much easier to locate topics of interest.
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A Note about Usenet Etiquette

Since articles posted to Usenet are distributed to thousands of news servers around the world and
can be read by millions of people, it’s important that users understand how to post correctly and
that they understand proper Usenet etiquette. Before posting, you should look at the articles in
news.announce.newusers and news.answers. One particularly good article is A Primer on How
to Work With the Usenet Community by Chuq Von Rospach. This article is posted frequently in
both news.announce.newusers and news.answers; it is also located on Barney’s web site at
http://barney.gonzaga.edu/tech/usenetcommunity.html.

Breaking the rules of Usenet can result in a lot of hostile mail (called flames) from other users on
Usenet. Using Usenet can be fun and informative but it’s important to be knowledgeable about
posting and be prepared to have your opinions blasted by others that disagree with you.

Using Outlook Express to Read Usenet News

Outlook Express is capable of connecting to a Usenet news server and downloading articles to
read. The following instructions assume that you have already set up the news server
(news.gonzaga.edu) when configuring Outlook Express in Chapter 5 of this manual. Another
newsreader called “slrn” is available if you telnet into Barney.

To read articles in Usenet news, do the following:

1. Open Outlook Express.

2. Click on “news.gonzaga.edu” in the folder list.

3. Expand the newsgroup list by clicking on the
minus sign next to news.gonzaga.edu on the PC
or the small triangle on a Mac.

4. To read the articles in a newsgroup, click on the
name of the newsgroup you want to read.

Note: If you aren’t currently subscribed to any newsgroups, Outlook Express will ask you if
you want to download a list of newsgroups.

Outlook Express will download the articles for the newsgroup you clicked on. The window
will be divided into two panes, the top pane will list all the articles in the newsgroup and the
bottom pane will show the text of the currently selected article. Unread articles will be bold
text and previously read articles will be plain text.

5. To read an article, click on the article subject.

http://barney.gonzaga.edu/tech/usenetcommunity.html
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Note: Articles with the same title are grouped
into a “thread” to make it easier to follow the
discussion. Threads are indicated by a plus
sign (PC) or a triangle (Mac). A thread can be
expanded or contracted by simply clicking on
the appropriate symbol.

6. To reply or post a response to the current
article, select the appropriate reply type from
the “Message” menu.

Your response can be sent back to the original
poster, to the newsgroup itself, or both.

Once you’ve completed your message/article, send it by clicking on the “Send” button.

7. If you want to post a new article, click on the “New Post” button.

Subscribing to Newsgroups

You can read the articles within a newsgroup whether you are subscribed to the newsgroup or
not; subscribing to a newsgroup just makes the newsgroup easier to access. Subscribing to a
newsgroup tells Outlook Express to list the newsgroup in your folder list and to keep track of
which articles you’ve read. It does not mean that you will receive mail from the newsgroup nor
does it inform anyone else that you are subscribed to the newsgroup. You can subscribe or
unsubscribe to a newsgroup at any time.

To subscribe to a newsgroup:

1. Launch Outlook Express.

2. Click on “news.gonzaga.edu” in the folder list.

3. Click on the “Newsgroups…” button in the
right pane.

A “Newsgroup Subscriptions” window appears that lists all the newsgroups on the current
news server (in this case, news.gonzaga.edu).

4. You can either enter a filter in the “Display newsgroup that contain” box or you can scroll
through the list to select a newsgroup.

5. Click on the newsgroup(s) you want to subscribe to and click “subscribe.”



Page 22 Using Usenet News

6. Once you are done subscribing to newsgroups, click the “OK” button.

While there are many thousands of groups, there is not one for every topic imaginable so you
may not be able to find the topic you are interested in. If that’s the case, you might look for a
more general topic newsgroup that would be appropriate for the discussion of the topic you have
in mind.

Unsubscribing from Newsgroups

If you are no longer interested in reading a particular newsgroup, you can easily unsubscribe from
it. To unsubscribe from a newsgroup, simply click on the newsgroup name in the folder list,
right-click and select “Unsubscribe” from the pop-up menu. This will remove the newsgroup
from your folder list and delete any information about the newsgroup from Outlook Express.

Dealing with High Volume Newsgroups

When you’re reading a newsgroup, there will often be messages that you don’t read. This is
especially true on high volume groups that can receive hundreds of new articles a day. To reduce
the clutter of a high volume newsgroup, you can mark all the articles as read and then only view
unread articles. This will reduce the total number of articles listed, making it much easier to
browse through.

To hide read articles, do the following:

1. Open the newsgroup and read the articles you are interested in.

2. When you are done reading articles, “Mark All Read” from the Edit menu.

3. Next time you open the newsgroup for reading, select “Hide Read Messages” from the
Current View sub-menu of the View menu.

This will hide all the previously read articles.

A Note about Usenet and Spam

Because of Usenet’s distributed nature, it is a prime target for spammers to post their spam on
and to “harvest” e-mail addresses to mail spam to. Every time you post an article on Usenet,
your e-mail address is being distributed all over the world to thousands of servers. Spammers
collect the e-mail addresses of Usenet posters and add them to their spamming lists. We attempt
to block spam coming into Gonzaga, but posting to Usenet will increase the likelihood that you
will receive spam messages.
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Student Web Pages on Barney
Introduction

The main academic server (Barney) is available for hosting student created web pages. Web pages
located on Barney can be accessed by anyone using a browser on the World-Wide Web. These
pages might be used for personal information, student projects, entertainment, resumes, or any
other information you may wish to provide that you would like others to see.

Restrictions

Anyone that has an account on Barney may have a web page including students, clubs, and
employees of Gonzaga. The creation and display of web pages are governed by Gonzaga
University’s Acceptable Use Policy. The disk space consumed by web pages counts against the
total disk space allotment your account is allocated on Barney. The amount of disk space your
account is using is displayed each time you telnet into your account. For the 2002-2003 school
year, students have a 100 megabyte limit.

Location of Web Files on Barney

The web server on Barney cannot access any of the files or directories in your account other than
the directory “public_html” located in your root directory. When your account was created, the
public_html directory was automatically created for you with the proper permissions.

The files “index.html” or “index.htm” are the two possible default web pages within your
public_html directory (or any sub-directory within public_html). Either name will work. The
default web document is the one that will be opened if no specific file is specified in the URL.
For example, http://barney.gonzaga.edu/~jdoe will display the index.html file in jdoe’s
public_html directory while http://barney.gonzaga.edu/~jdoe/resume.html will display the
resume.html file in jdoe’s public_html directory. It’s always a good idea to have a default web
page in your public_html directory so people have a starting web page for your account.

File and Directory Permissions

In order for a web page to be readable by the web server, the files and directories in your
“public_html” directory must have public read permissions. When using FTP to transfer files or
creating new files or directories on Barney, Barney will automatically create the file with the
proper permissions so that you don’t have to set them manually. If you do need to modify
permissions to make a file readable by everyone, type “chmod 644 filename” at the $ prompt,
replacing filename with the actual name of the file to set. You MUST be in the same directory as
the file for this to work! To make a directory or script readable by everyone, type “chmod 755
directoryname” at the $ prompt. See “man chmod” on Barney for more information.

http://barney.gonzaga.edu/~jdoe
http://barney.gonzaga.edu/~jdoe/resume.html
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Transferring Files to Barney

HTML documents may be created directly on Barney or may be created on a different computer
and then uploaded to Barney. Files can be uploaded to Barney using FTP if there is a direct
connection (e.g., your computer is on ZagNet) or modem PPP connection (i.e., connecting via an
ISP) between your computer and Barney. If you are connecting over a modem and are not using
PPP, the file may be uploaded using a modem transfer protocol. If you are logging into a
computer lab using your ZagNet account, you can access your “public_html” folder on PCs at
H:\public_html or using the “myfiles” icon on Macs in computer labs. For more information on
transferring files to Barney, see the document titled Downloading Files from Barney using FTP.

Accessing Student Web Pages from the World-Wide Web

Once you have placed your web pages on Barney and have set the access permissions correctly
(if required), others may access your pages. The URL (Universal Resource Locator) for your
default web page is http://barney.gonzaga.edu/~youruserid. For example, if your userid was
“jdoe,” the URL for your default page would be http://barney.gonzaga.edu/~jdoe. Your default
page is named either “index.html” or “index.htm” and is located in your “public_html”
directory on Barney. Other pages can be accessed directly by entering the name of the web page
after your userid. For example, http://barney.gonzaga.edu/~jdoe/resume.html would display the
file “resume.html” in your public_html directory.

Creating HTML Documents

Web pages are commonly referred to as HTML documents because they use the HyperText
Markup Language (HTML) to provide formatting information. There are many programs that
can create HTML documents including Netscape Communicator, Claris Home Page, Front Page,
Microsoft Office 97 or later (and earlier versions with free plug-ins from Microsoft), and dozens
of other programs. Since HTML documents are simply text documents with special “tags” to
provide formatting information, they can also be created using text editors and word processors.
These include text editors on Barney such as pico, vi, and emacs. How you create the documents
is arbitrary and depends on your preferences. The web server on Barney doesn’t care which
program created the web page as long as it is in the correct format and is named properly.

One thing that is very important to remember is that filenames and the Apache web server on
Barney are case-sensitive. This means that the filenames referred to in the HTML documents
must exactly match the name and case of the actual file. For example, if you refer to
“RESUME.HTM” in your HTML source code but the actual file was called “resume.htm”, the
link would fail because it wouldn’t be able to find the file. It’s recommended that you always use
lowercase letters to reduce the likelihood of this problem occurring.

There are dozens of books on creating web pages and many excellent tutorials and resources on
the Internet. A number of classes at Gonzaga also teach web page development.

http://barney.gonzaga.edu/~youruserid
http://barney.gonzaga.edu/~jdoe
http://barney.gonzaga.edu/~jdoe/resume.html
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Enrolling in Blackboard 5 Courses
What is Blackboard?

Blackboard is a web-based learning and communication tool that is used in many courses at
Gonzaga. It enables the professor to share information and documents with the students of a
course and for the students and professor of the course to participate in online discussions.

To Create an Account on Blackboard

Note: If you have already created a Blackboard account at Gonzaga University please do not
create a new one even if you created the account in the previous version of Blackboard – you
can use one account to enroll in multiple courses.

1. Launch Netscape or Internet Explorer.
2. Go to “http://webclass.gonzaga.edu/”
3. Click on "Create New Account" at the left side of the screen.
4. Enter your name and e-mail address.
5. Choose a User Name and Password you can easily remember.
6. Scroll to the bottom of the screen and click on the “Submit” button.

To Login to Your Blackboard Home Page

1. Using Netscape or Internet Explorer, go to http://webclass.gonzaga.edu/ and click on the
“Login” button.

2. Enter your Username and Password and click on the “Login” button.

This will bring you to the “My Blackboard” portal. Courses in which you are enrolled are
listed in the “My Courses” section on the top right side of the screen.

To Enroll in a Course

1. Click on the “Courses” tab at the top of the screen.
2. Using the Course Catalog list on the right side of the screen, navigate to the course into which

you are enrolling (e.g. Arts and Sciences | Criminal Justice | CRIM101). You can also search
for a course by Course Name, Course ID, or Username by using the “Course Search” tool at
the top left of the Courses page.

3. Click on the “Enroll” button to the right side of the listing of the course.
4. Click on the “My Blackboard” button at the top of the screen.

You will now see the course in the “My Courses” listing at the top right of the screen.

http://webclass.gonzaga.edu/%E2%80%9D
http://webclass.gonzaga.edu/


Gonzaga University Computer Labs - Fall 2002

Bldg Room Normal Hours (1) Type Software Print(3) Restrictions Contact

Admin 243 24 Hours Win2000 MS Office XP Pro, MS Publisher 2000 Laser Lab closed occasionally for classes Vicki Craigen (x5552)

Mac MS Office 2001, AppleWorks Printing requires copy card @ 5¢ per page

Mac HP Scanner, Photoshop, Corel Paint Headphones required for sound

Admin 134 TBA W2K MS Office 2000 Pro, WordPerfect 8 Laser Hours dependent upon tutor availability Brett Hendricks (x3910)

Admin 430 24 Hours Mac MS Office 2001, Desktop Publishing Laser Comm Arts students have 24 hr access Brett Hendricks (x3910)

Foley ISM Library Hours Win2000 MS Office XP Pro, MS Publisher 2000 Laser Printing requires copy card @ 5¢ per page Brady Nielsen (x3862)

Mac MS Office 2001, AppleWorks Headphones required for sound

Herak 220 TBA Various Dynamic configuration to meet class needs Laser Access limited to certain classes Brett Hendricks (x3910)

Herak 223 TBA Win2000 MS Office 97 Pro, Visual Studio 6.0 DotMat Hours dependent upon workstudy availability Brett Hendricks (x3910)

InkJet Must have a lab account

Herak 101/105 24 Hours Win2000 MS Office XP, MS Project, AutoCAD, Visio Express, Laser Engineering students only Patrick Nowacki (x6819)

MathCAD, Matlab, Ansys, SolidWorks, Inventor Color Engineering students have 24 hr access

Plotter

Hughes 137 M-F 8a-5p Mac Biology software Laser Biology classes and students only Sherry Woods (x6626)

Jepson 07 M-Th 9a-10p, F 9a-5p Win2000 MS Office 2000 Pro Laser Lab closed occasionally for lectures Bob Toshack (x3407)

Sat 12p-5p, Sun 2p-10p Color

Jepson 012 Hours as posted Win2000 MS Office 2000 Pro Laser Instructional Lab. Open lab hours posted Bob Toshack (x3407)

Music Office hours Win2000 MS Office 2000 Pro, Music Composition Laser Music students only Brett Hendricks (x3910)

Rosauer 101 M-Th 8a-9p Mac MS Office 2001, AppleWorks, PageMaker, Photoshop Laser Educational students have priority Jason Gilman (x3660)

F 8a-6p, Sun 6p-10p Win2000 MS Office XP Pro

(1) Hours of computer labs subject to change.
(2) MS Office includes Word, Excel, PowerPoint. MS Office Pro also includes Access database software.
(3) Some computer labs charge for printing to laser or color printers. Contact that lab for details.
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Purchasing a Computer
There are a number of things to keep in mind when purchasing a computer. These include what
field you are entering, whether or not you will be working on a network, what type of work you
will be doing on the computer, and how often you can afford to replace the computer. You may
also want to take into consideration the entertainment side of computers since many personal
computers that are purchased for business purposes are also used to play games.

General Purchasing Recommendations
Purchase a computer from a tier-one vendor such as Dell, Gateway, Micron, etc.. These
companies provide telephone support 7 days/week, and usually 24 hours/day, and they often
provide on-site service during the first. In general, any system you purchase from a vendor such
as this will be adequate for general-purpose computing. If you are planning to major in areas such
as Engineering, Computer Science, etc., contact a representative in that discipline for more
specific information.

If you are planning to live in a residence hall you will need a network interface card to connect
your computer to the ZagNet campus network. We recommend that you purchase a network
card from the SMC Corporation (recommended card – SMC 2206USB). University technical
staff have a great deal of experience installing, configuring, and supporting this product line. If
you wish to wait until you arrive on campus, the University can sell you an appropriate SMC
network card, then install and configure it for you at no charge. Look for information about
ZagNet Connection Central when you arrive.

Contacts
If you wish to discuss computing needs with someone from a particular academic school or
college, please contact one of these individuals:

Business: Robert Toshack – (509) 323-3407 / toshack@jepson.gonzaga.edu
Education: Jason Gilman – (509) 323-3660 /  jgilman@soe.gonzaga.edu
Engineering: Patrick Nowacki – (509) 323-6819 / nowacki@gem.gonzaga.edu
Math/Computer Science: Brett Hendricks – (509) 323-3910 / hendricks@gonzaga.edu
General Questions: Chris Gill – (509) 323-3827 / gill@its.gonzaga.edu

Gonzaga University Configuration Support
If you are living on-campus, technical staff will be available to assist you in configuring your
computer to function on the University’s on-campus network. They can install and configure an
SMC Ethernet adapter, network software, and a selected set of applications necessary to use the
ZagNet student network.
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Typical Configuration for Students
The following are typical configurations available in June, 2002. They are meant to be used as a
baseline for making a purchasing decision. These systems will not meet the needs of everyone.
Check with your computer vendor for current configuration and pricing.

PC w/Windows Minimum Recommended
Processor: Intel Celeron 700mhz Pentium 4 1.6GHz
Memory: 128 MB RAM 256 MB RAM
Hard Disk: 20 GB 40 GB
CD-ROM: 48x DVD-ROM/CD-RW
Monitor: 15” SVGA 17” SVGA
Modem: 56 kbps v.90 56 kbps v.90
Sound: 16-bit SoundBlaster 32-bit SoundBlaster
Network: SMC 2206USB SMC 2206USB

Macintosh Minimum Recommended
Processor: iMac or eMac iMac 600 or G4 PowerMac
Memory: 128 MB RAM 256 MB RAM
Hard Disk: 10 GB 40 GB
CD-ROM: Standard Speed DVD-ROM/CD-RW
Monitor: 15” Color 17” Color
Modem: 56k kbps v.90 56 kbps v.90
Sound/Network: Built-in Built-in

Other Frequently Asked Questions

Do I have to buy a computer? No, the University does not require personal computers. Each
major school or college supports at least one computer lab for student use, and two general-
purpose labs (one in AD243 in the Administration building and one the Foley Center Library) are
available to students at the University. The Administration building general-purpose lab
(AD243) is open 24-hours per day. However, students are encouraged to purchase a computer
for residential use since labs are heavily used and space may not be available at all times.

Should I buy a laptop or desktop computer? This is a personal decision, that should be based
on several factors, including how you plan to use the computer, how much you can afford to
pay, how important computing mobility is to you, and where and how you plan to use the
computer. Laptop computers are more portable and convenient, but they are also more easily
damaged and more expensive.

How do I get connected to the Network? Gonzaga University’s student network, called
ZagNet, is available to students living in residence halls on campus. The network is a high-speed
Ethernet network and requires that an Ethernet network interface card be installed in your
computer. The cards can be pre-installed by your computer vendor or installed on campus by
University technical support staff. Installation of the card is available at no charge, however costs
for the card, Ethernet cable, and documentation are charged at the time of installation. After
installing the Ethernet card, University technical staff configure the computer to function on
ZagNet and confirm correct operation. Please look for information about ZagNet Connection
Central when you arrive on campus.
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Internet Worksheet
Introduction

Every computer connected to ZagNet requires certain address information that will uniquely
identify it to the network and will allow it to communicate with other computers on the Gonzaga
campus and the Internet. This information can be set automatically using DHCP or manually using
the following worksheet to determine the values for your computer.

Auto-Configuration using DHCP

Most computers in the residence halls can utilize the ZagNet DHCP servers to auto-configure their
basic networking information (IP address, gateway, and DNS servers). See the ZagNet CD for
instructions on configuring DHCP on your computer or contact the Help Desk at x5550. In the
event that your computer does not support DHCP or has difficulties with Gonzaga’s DHCP
services, your network settings can be configured manually using the information below.

Information for Manual Configuration of Network Settings

The following information is required in order for your Internet connection to work properly:

IP Address: 147.222.______.______  (e.g., 147.222.131.125)

The IP address is the unique identifier for your computer. It is
a series of four numbers separated by periods. All Gonzaga IP
addresses begin with “147.222.”. For residence halls, the
third number specifies the residence hall (see back of this
form) and the fourth number is the specific port number in the
residence hall. The port number is written on the wall jack
where you connect the network cable.

Router/Gateway Address: 147.222.______.254  (e.g., 147.222.131.254)

The router/gateway address is unique for each residence hall.
See the back of this form for this list of addresses.

The following information is the same for each of the residence halls:

Subnet Mask: 255.255.255.0  (Class “C” address”)
DNS/Name Server Address: 147.222.1.253

 Backup DNS Server: 147.222.1.251
Search Domain: gonzaga.edu

Additional Information

The following information is used by various Internet applications such as e-mail clients, Usenet
news clients, etc.

SMTP/POP Server: barney.gonzaga.edu
NNTP/News Server: news.gonzaga.edu

LDAP Directory Server: whitepages.gonzaga.edu
Student Web Server: http://barney.gonzaga.edu

Student Web Mail: http://zagmail.gonzaga.edu

http://barney.gonzaga.edu
http://zagmail.gonzaga.edu
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Location Address Group Gateway Address Subnet Address
301 Boone 147.222.131.xxx 147.222.131.254 255.255.255.0
801 Boone 147.222.132.xxx 147.222.132.254 255.255.255.0
Alliance 147.222.133.xxx 147.222.133.254 255.255.255.0
Burch 147.222.134.xxx 147.222.134.254 255.255.255.0
Campion 147.222.135.xxx 147.222.135.254 255.255.255.0
Crimont 147.222.136.xxx 147.222.136.254 255.255.255.0
Cushing 147.222.137.xxx 147.222.137.254 255.255.255.0
Desmet 147.222.138.xxx 147.222.138.254 255.255.255.0
Dooley 147.222.139.xxx 147.222.139.254 255.255.255.0
Dussault 147.222.140.xxx 147.222.140.254 255.255.255.0
Lincoln 147.222.141.xxx 147.222.141.254 255.255.255.0
Madonna 147.222.142.xxx 147.222.142.254 255.255.255.0
Rebmann 147.222.143.xxx 147.222.143.254 255.255.255.0
Roncalli 147.222.144.xxx 147.222.144.254 255.255.255.0
St. Catherine 147.222.145.xxx 147.222.145.254 255.255.255.0
St. Monica 147.222.146.xxx 147.222.146.254 255.255.255.0
Sharp Apt/House 147.222.147.xxx 147.222.147.254 255.255.255.0
Welch 147.222.148.xxx 147.222.148.254 255.255.255.0
Chardin 147.222.149.xxx 147.222.149.254 255.255.255.0
Corkery 147.222.150.xxx 147.222.150.254 255.255.255.0
River Inn 147.222.151.xxx 147.222.151.254 255.255.255.0
Dillon 147.222.152.xxx 147.222.152.254 255.255.255.0
Goller 147.222.153.xxx 147.222.153.254 255.255.255.0
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Network and Computer Resource
Acceptable Use Policy

Section 1: Introduction

{a} This policy is established to make users of Gonzaga University’s computing resources aware of their privileges and responsibilities.

{b} This policy is established to maximize the value of those resources to the university community while permitting maximum
freedom of use consistent with law, the University’s mission statement, the Student Handbook, the Personnel Policies and
Procedures Manual, the Faculty Handbook, and a productive environment. Any use of Gonzaga University computing resources
which violates policies contained in these manuals and handbooks also violates this policy; nothing in this policy shall contradict
existing University policy.

{c} Violation of this policy can result in reprimand, reduction or loss of computing privileges, and/or referral to University authorities
for disciplinary action. Violation of law may result in referral to appropriate authorities.

{d} This policy provides general guidelines regarding the use of GUnet. Refer to http://www.gonzaga.edu/tech/aup/ for specific
examples of acceptable and unacceptable uses of GUnet as defined by this policy.

Section 2: Definitions

{a} GUnet -- the physical network media and the attached computers and software owned or controlled by the University. GUnet
includes ZagNet, the student network connecting the residence halls to the campus network.

{b} Internet -- the global computer network composed of millions of computers and thousands of networks.

{c} Logged on -- connected to a service with a non-public user identification (e.g., personal account).

{d} Resource -- any computing device, peripheral, software, or related consumable (e.g., paper, disk space, central processor time,
network bandwidth) owned or controlled by the University.

{e} Service -- any software that makes a computer’s files or other locally stored information available for use by another computer or
facilitates the transfer of data between two remote computers. Services include, but are not limited to, web, file, and e-mail server
software.

{f} Spam  -- unsolicited mass e-mail for the purpose of advertising a service, personal gain, or other inappropriate use.

Section 3: General Usage Statement

{a} Network and computing resources at the University are provided primarily to support the mission of the University. Users may
occasionally use GUnet for personal needs as long as such use is consonant with established University policy and does not inhibit
academic or administrative use of GUnet.

{b} The University cannot provide, and will not be responsible for, software kept on personally owned computers, nor are they
responsible for the installation, repair, maintenance or upgrade of personally owned hardware.

{c} Users should not leave a computer logged on if the user will be away from the computer for an extended period of time (e.g., two
hours) or the computer is in an unsecured area. Data on local hard drives should be secured either through password protection or
physical security (e.g., locked office) when the user is not present.

{d} Personal accounts are private and should not be shared with others.

{e} The use of University resources, including GUnet, for political gain or exclusive personal gain shall not be permitted.

http://www.gonzaga.edu/tech/aup/


Revised 10/29/98 Network and Computer Resource Acceptable Use Policy Page 2 of 2

{f} The University may restrict the use of computing and network resources. This includes blocking spam messages and deleting user
files and mail to conserve disk space on University owned computers.

{g} Employees, students, and other authorized users may post electronic documents and images (e.g. web pages) for public access
provided that those documents conform to policies contained within the documents listed in Section 1{b} and United States and
international copyright law.

Section 4: Unacceptable Uses

{a} Using GUnet for any unlawful activity.

{b} Sending spam or creating or retransmitting chain e-mail messages.

{c} Sending e-mail from another user’s account.

{d} Altering the header of an e-mail message to prevent the recipient from determining the actual sender of the e-mail.

{e} Logging into or using any computer account or accessing, modifying, or creating any files without the account owner’s permission.

{f} Introducing new services or resources (e.g., personal web server) or altering existing services or resources (e.g., registering personal
domain name) on GUnet without the approval of Information Technology Services.

{g} Transmitting, without authorization, information proprietary to the University or information that could be construed as a statement
of official University policy, position, or attitude.

{h} Distributing information encouraging the patronage of network sites containing material prohibited by policies contained within the
documents listed in Section 1{b}.

{i} Wasting resources such as print services, disk space, and network bandwidth.

{j} Intercepting network traffic without authorization.

{k} Using GUnet for any activity that results in degradation of University provided services, denies services to other GUnet users, or
jeopardizes the security or capabilities of GUnet.

Section 5: Privacy

{a} Under ordinary and normal circumstances, a user’s computer files -- including electronic mail -- are considered private. In order to
correct system problems or investigate misuse of resources, it may be necessary for system administrators to examine users’ files
(including e-mail and network traffic). In such cases, user privacy will be respected to the extent possible consistent with University
policy and the law.

{b} Personal web pages and e-mail addresses may be listed on University directories unless the user specifically requests that this
information be kept confidential.

Section 6: Agreement

{a} I understand that access to GUnet is a privilege and not a right. I acknowledge that failure to conform to this policy statement may
result in revocation of my GUnet account(s) and/or network access. Furthermore, disciplinary action consistent with University
policy may be taken by the appropriate University officers (e.g., Student Life, Department Chair, supervisor) and illegal activities
may be referred to the appropriate authorities.

{b} I understand the above stated conditions for accessing GUnet and the Internet, and I agree to abide by these terms and conditions. I
understand that certain material found on the Internet is offensive to some people and that I access the Internet of my own free
will. Furthermore, I request access to Gonzaga University computing resources and/or an account on GUnet.

_________________________________________________________________________________________________________

Name of user (printed)

_________________________________________________________________________________________________________

Signature of user Date


